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SNMP Basics
 
		Network Management
		  Systems use the Simple Network Management Protocol (SNMP), an industry-standard
		  protocol, to exchange management information between network devices. SNMP
		  enables administrators to remotely monitor network/application performance,
		  find and solve network problems, and plan for network growth. 
		
 
		An SNMP-managed
		  network contains managed devices, agents, and Network Management Stations
		  (NMS). Management Information Bases (MIBs) are used to structure the
		  information that passes between the components in the system. 
		
 
			 
			 A managed device
				designates a network node that contains an SNMP agent and resides on a managed
				network. Managed devices collect and store management information and make it
				available by using SNMP. 
			 
 
			 The following
				Unified ICM/CCE components are valid managed devices: 
			 	 
				  Routers 
				  
 
				
	 
				  Loggers 
				  
 
				
	 
				  Peripheral
					 Gateways (PGs) 
				  
 
				
	 
				  Administration & Data Server 
				  
 
				
	 
				  CTI Gateways
					 (CGs) 
				  
 
				
	 
				  CTI OS
					 Servers 
				  
 
				
	 
				  Outbound
					 Option 
				  
 
				

 
			 
 
		  
	 
			 An agent resides
				on a managed device. An agent (or one of its subagents) retrieves local
				management information and translates it into the SNMP format to forward it to
				an SNMP Management Station. Subagents collect information for various
				components and then forwards that information to a master agent. 
			 
 
			 Unified ICM/CCE
				supports the following agents: 
			 	 
				  SNMP Master
					 Agent 
				  
 
				
	 
				  Unified
					 ICM/CCE Application (CISCO-CONTACT-CENTER-APPS-MIB) Subagent 
				  
 
				
	 
				  Platform
					 Subagent(s)1 
				  
 
				
	 
				  System
					 Applications Instrumentation (SYSAPPL-MIB) Subagent 
				  
 
				
	 
				  Host
					 Resources (HOST-RESOURCES-MIB) Subagent 
				  
 
				

 
			 
 
		  
	 
			 A Network
				Management Station (NMS) comprises an SNMP management application together with
				the computer on which it runs. An NMS executes applications that monitor and
				control managed devices. An NMS provides the bulk of the processing and memory
				resources that are required for network management. Cisco Unified ICM/CCE SNMP
				works with SNMP standards-compliant NMSs. 
			 
 
		  
	 
			 A Management
				Information Base (MIB) designates a collection of information that is organized
				hierarchically. You can access instrumentation defined by a MIB using the SNMP
				protocol. MIBs are composed of managed objects, which are identified by object
				identifiers. 
			 
 
			 A managed object
				(sometimes called a MIB object or an object) possesses one of any number of
				specific characteristics of a managed device. Managed objects comprise one or
				more object instances, which are essentially variables. 
			 
 
			 Cisco Unified
				ICM/CCE supports the following MIBs: 
			 	 
				  CISCO-CONTACT-CENTER-APPS-MIB 
				  
 
				
	 
				  HOST-RESOURCES-MIB 
				  
 
				
	 
				  SYSAPPL-MIB
					 - (System-Level Managed Objects for Applications) 
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Cisco Contact Center Application MIB
 
		The Cisco Contact Center Application (CISCO-CONTACT-CENTER-APPS) MIB
		  contains tables of objects and their corresponding values for the major
		  components of a Unified ICM/CCE Enterprise/Hosted Edition installation. 
		
 
		Components include: 
		
 
			 
			 Router (and a table of NICs) 
			 
 
		  
	 
			 Logger 
			 
 
		  
	 
			 Peripheral Gateway (PG) (and a table of PIMs) 
			 
 
		  
	 
			 Distributor Administration and Data Server 
			 
 
		  
	 
			 CTI Gateway (CG) 
			 
 
		  
	 
			 CTI OS Server 
			 
 
		  
	 
			 Outbound Option 
			 
 
		  

 
		The MIB definition can be viewed by opening the file: 
		  <INSTALL_DRIVE>\icm\snmp\CISCO-CONTACT-CENTER-APPS-MIB.my
		  in a text editor or a MIB browser. 
		
 
		The MIB also provides a notification object which defines the format
		  of SNMP notifications generated by Unified ICM/CCE components. The SNMP
		  subagent on the Unified ICM/CCE Logger component sends alarms to the NMS. 
		
 
		The CISCO-CONTACT-CENTER-APPS-MIB is available at: 
		  ftp://ftp.cisco.com/pub/mibs/v2/CISCO-CONTACT-CENTER-APPS-MIB.my.
		  
		
 
	 
Related Information
Unified ICM/CCE notifications


Host Resources MIB

		The Host Resources MIB found in Cisco SNMP is an implementation of the
		  Host Resources MIB document, proposed standard 
		  RFC
			 1514. It is also compliant with Host Resources MIB, draft standard 
		  RFC 2790. This
		  MIB defines objects that are useful for managing host systems and allows SNMP
		  access to useful host information, such as the storage resources, process
		  table, device information, and the installed software base.
		

	 

System-level Managed Objects for Applications MIB

		 The System-level Managed Objects for Applications (SYSAPPL) MIB, 
		  RFC 2287, supports configuration, fault detection,
		  performance monitoring, and control of application software. It provides for
		  tables that define an application as a series of processes and services. This
		  includes objects for applications installed on the system, elements and
		  processes that are included in an application, and current and previously run
		  applications.
		

		For more detailed information about monitoring and managing a Unified
		  ICM/CCE deployment, see the 
		  Serviceability Guide for
				  Cisco Unified ICM/Contact Center Enterprise available at 
		  http://www.cisco.com/en/US/products/sw/custcosw/ps1844/products_installation_and_configuration_guides_list.html.
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Installation
	 Prerequisites for SNMP Support
[/reference/titlealts/navtitle
       {"- topic/navtitle "}) Installation
		Prerequisites for SNMP Support
	  (navtitle]
 
		Unified CCE SNMP
		  support is automatically installed during the course of normal setup. No extra
		  steps need be taken 
		  during setup
		  for SNMP support to be enabled. However, Microsoft Windows SNMP optional
		  components must be installed on Unified ICM/CCE servers for any SNMP agents to
		  function. 
		
 
		Install the appropriate Microsoft
		  Windows SNMP component(s) before installing any Unified ICM CCE components that
		  require SNMP monitoring. Following are the instructions to install the
		  Microsoft Windows SNMP components. 
		  
		
 
			[image: images/note.gif]
Note
	The Microsoft
		  SNMP component(s) are required for Cisco SNMP support. The Microsoft Windows
		  SNMP service is disabled as part of web setup and is replaced by the Cisco
		  Contact Center SNMP Management service to process SNMP requests in its place.
		  The Cisco Contact Center SNMP Management service provides for more
		  sophisticated SNMP capabilities than the standard Microsoft SNMP Service. 
		


 
	 
	Install Microsoft Windows SNMP Components on Windows Server


Install Microsoft Windows SNMP Components on Windows Server

            See the Microsoft documentation to install Microsoft Windows SNMP components on the Windows Server. 

        

Cisco Contact Center SNMP Solution Configuration
[/topic/titlealts/navtitle
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The Cisco Contact Center SNMP solution is configurable from a Microsoft
		Management Console (MMC) Snap-in.
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	Add Cisco SNMP Agent Management Snap-In
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Basic Configuration
[/reference/titlealts/navtitle
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		While all SNMP components are installed and enabled by default, the
		  device is not manageable via an NMS until the solution is properly configured.
		  For security reasons, certain parameters are not configured by default.
		

		The system administrator must configure the following to grant access
		  to the agents and enable the receipt of SNMP notifications:
		

			
			 Configure the Community Name or User Names:
			 

			 	
				  If you are using SNMP version 1 or version 2c, at least one
					 community string must be configured on each Unified ICM/CCE server to be
					 managed (see below), OR
				  

				
	
				  If using SNMP version 3, configure at least one user name on each Unified ICM/CCE server to be managed (see below).
				  

				


		  
	
			 Configure General Properties. 


		  
	
			 For trap forwarding, configure an SNMP trap destination on each Unified ICM/CCE Logger server. You can also optionally add a Syslog
				Destination. 

		  


		You can use the Cisco SNMP Agent Management
		  MMC Snap-in to configure all properties.
		

			[image: images/note.gif]
Note
	Some diagnostic tools use SNMP locally to gather information
		  about the system using one of the community strings configured for Windows
		  SNMP. These community strings are not added to the Contact Center SNMP
		  configuration, which causes SNMP requests from these diagnostic tools to
		  fail. Add all communities configured for Windows SNMP to the
		  Contact Center SNMP configuration. It is not necessary for the Windows SNMP
		  service to be started or enabled. To find the Windows SNMP communities in
		  the 
		  "Security" tab  select 
		  "properties" for the Windows SNMP service from the list of Windows
		  services.
		



	 
Related Information
General properties configuration
Configuration of trap and Syslog destinations


Add Cisco SNMP Agent
	 Management Snap-In
[/task/titlealts/navtitle
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		Agent Management 
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		You can configure
		  Cisco SNMP Agent Management settings using a Windows Management Console
		  Snap-in. To add the Snap-in and change Cisco SNMP Management settings: 
		
 
	 Procedure


	Step 1	From the Start menu select Run.. 

	Step 2	In the Start box type in mmc/32 and press ENTER. 

						Attention
	The Cisco SNMP Agent Management Snap-In is a 32-bit snap-in and is only available when the “/32” switch is used. 



				

	Step 3	From the
			 Console, select 
			 File > Add/Remove
				  Snap-in 
		  
 
			 A new window
				appears. 
			 
 
		  

	Step 4	From the 
			 Selected
				Snap-ins tab, verify 
			 Console
				Root is selected in the 
			 Snap-ins
				added to: field and click 
			 Add. 
		  

	Step 5	In the Available Snap-ins window, scroll down and select Cisco SNMP Agent Management. 

	Step 6	In the Add Snap-in
			 window click 
			 Add. 
		  

	Step 7	In the Add Snap-in window click Close. 

	Step 8	Click 
			 OK in the 
			 Add/Remove Snap-in window. 
		  
The Cisco
			 SNMP Agent Management Snap-in is now loaded in the console. 
		  





Saving Snap-In
	 View
[/task/titlealts/navtitle
       {"- topic/navtitle "}) Saving Snap-in
		View
	  (navtitle]
 
		After you load the Cisco SNMP Agent Management MMC Snap-in, you can save that console view to
		  a file (with a .MSC file extension) that you can  launch  directly, instead of
		  repeatedly adding the Snap-in to a new MMC console view. To do so, select the 
		  File > Save
				As menu; a 
		  Save
			 As dialog  appears. 
		
 
		Select a memorable
		  file name such as 
		  Cisco SNMP
			 Agent Management.msc (retain the .msc file extension) and save the
		  file to the desired location. The Administrative Tools (start) menu is the
		  default location, which makes it conveniently available for later access via
		  the Start menu. 
		
 
	 

Configure Community
	 Name for SNMP v1 and v2c
[/task/titlealts/navtitle
       {"- topic/navtitle "}) Configure
		Community Name for SNMP
	  (navtitle]
 
		If you use SNMP v1 or v2c, configure a Community Name so that the Network Management Stations (NMSs) can access the data that your server provides. These names are left blank during the installation for security reasons. 
 
		SNMP Community Names
		  are used to authenticate data exchange of SNMP information. An NMS can exchange
		  SNMP information only with servers that use the same Community Name. 
		
 
		To configure the
		  Community Name for SNMP v1 and v2c: 
		
 
	 Procedure


	Step 1	Follow the steps
			 in 
			 How to
				install the Cisco SNMP Agent Management Snap-in to access the Cisco
			 SNMP Agent Management settings. 
		  

	Step 2	Expand 
			 Cisco
				SNMP Agent Management in the left pane of the MMC plugin. 
		  

	Step 3	Highlight 
			 Community Names (SNMP v1/v2c) in the left pane under
			 Cisco SNMP Agent Management. 
		  
Community
			 Name, SNMP Version, and Restricted Access columns appear in the middle pane. 
		  

	Step 4	Right click on
			 the white space in the right pane and choose 
			 Properties. 
		  
A dialog
			 box appears. 
		  

	Step 5	Click 
			 Add new
				Community. 
		  

	Step 6	In the dialog
			 box, under 
			 Community Information, provide a community name. 
		  

	Step 7	Select the 
			 SNMP
				Version by selecting the radio box for SNMP V1 or SNMP V2c. 
		  

	Step 8	Optionally,
			 enter one or more IP addresses in the IP Address entry field (containing 
			 "dots"). Click 
			 Insert to enable the access solely for this
			 community from the NMS with the IP Address provided. 
		  

	Step 9	Click 
			 Save. 
		  
 
			 The community
				name appears in the 
				Configured Communities section at the top of the
				dialog box. 
			 
 
			 	Note
	You can
				remove the community name by highlighting the name in the 
				Configured Communities section and clicking 
				Remove
				  Community. 
			 


 
		  



 
		Changes become
		  effective when you click 
		  OK. 
		
 
	 

Configure User Name
	 for SNMP v3
[/task/titlealts/navtitle
       {"- topic/navtitle "}) Configure User
		Name for SNMP
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		If you are using
		  SNMP v3 you must configure a User Name so that Network Management Stations
		  (NMSs) can access the data provided by your server. By default, these names are
		  left blank for security reasons. 
		
 
		To configure a User
		  Name for SNMP v3: 
		
 
	 Procedure


	Step 1	Follow the steps
			 in 
			 How to
				install the Cisco SNMP Agent Management Snap-in to access the Cisco
			 SNMP Agent Management settings. 
		  

	Step 2	Expand 
			 Cisco
				SNMP Agent Management in the left pane of the MMC plugin. 
		  

	Step 3	Highlight 
			 User
				Names (SNMP v3) in the left pane under Cisco SNMP Agent Management.
			 
		  
User
			 Name, Authentication, Privacy, and Restricted Access columns appear in the
			 middle pane. 
		  

	Step 4	Right click on
			 the white space in the right pane and choose 
			 Properties. 
		  
A dialog
			 box appears. 
		  

	Step 5	Click 
			 Add
				User. 
		  

	Step 6	In the 
			 User
				Configuration text box enter a user name. 
		  

	Step 7	If you wish to
			 use SNMP v3 authentication, check 
			 Required? under Authentication, choose an
			 authentication protocol, then enter and confirm a password. 
		  
 
			 This setting
				encrypts the password information as it is sent over the network. 
			 
 
			 	Note
	These
				settings must also be used on your NMS to access SNMP data from this server. 
			 


 
		  

	Step 8	If you wish to
			 use SNMP v3 privacy, check 
			 Required? under Privacy, choose an encryption type,
			 and enter and confirm a password. 
		  
 
			 	Note
	
				
					
					 This
						setting encrypts all SNMP information as it is sent over the network. If
						privacy is configured, authentication is required, but authentication can be
						configured without configuring privacy. 
					 

				  
	
					 These
						settings must also be used on your NMS to access SNMP data from this server. 
					 

				  


				

			 


 
		  

	Step 9	Optionally,
			 enter one or more IP addresses in the IP Address entry field (containing 
			 "dots") and
			 click 
			 Insert to enable access solely from the NMS with the
			 IP Address provided. 
		  

	Step 10	Click 
			 Save. 
		  
 
			 The User Name
				appears in the 
				Configured Users section at the top of the dialog
				box. 
			 
 
			 	Note
	You can
				remove the User Name by highlighting the name in the 
				Configured Users section and clicking 
				Remove
				  User. 
			 


 
		  



 
		Changes become
		  effective when you click 
		  OK. 
		
 
	 
Related Information
Configuration
		  of trap and Syslog destinations
		


General Properties Configuration
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the Cisco 
Contact Center SNMP solution configuration to 
access the configuration screens.

	Configure General Information Properties for Cisco SNMP Agent Management


Configure General
	 Information Properties for Cisco SNMP Agent Management
[/task/titlealts/navtitle
       {"- topic/navtitle "}) SNMP Agent
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	  (navtitle]
 
		You can configure
		  general information properties for Cisco SNMP within the Cisco SNMP Agent
		  Management Snap-in. 
		
 
		To configure general
		  information properties: 
		
 
	 Procedure


	Step 1	In the Cisco
			 SNMP Agent Management Snap-in, expand 
			 Cisco
				SNMP Agent Management in the left pane of the MMC plugin. 
		  

	Step 2	Highlight 
			 General
				Information in the left pane under Cisco SNMP Agent Management. 
		  
Attribute, Value, and Description columns appear in the middle
			 pane. 
		  

	Step 3	Right click on
			 the white space in the middle pane and choose 
			 Properties. 
		  
A dialog
			 box appears. 
		  

	Step 4	You can change
			 the following properties in the 
			 SNMP
				System Information section of the General Information Properties
			 dialog box. 
		  
 
			 SNMP System
				Information Properties	 
						Property
						  
						
 
					 	 
						Description 
						
 
					 
	 
						System
						  name 
						
 
					 	 
						The
						  fully qualified domain name of the system. If system name is empty, it is automatically
						  filled in. 
						
 
					 
	 
						System
						  Location 
						
 
					 	 
						A text
						  area to describe the location of the hardware. For example 
						  Building 5, Floor 3, Room 310. 
						
 
					 
	 
						System
						  Contact 
						
 
					 	 
						The
						  name, email address and/or telephone number of the system contact. Enter
						  anything that aids an NMS user in contacting the system administrator. 
						
 
					 
	 
						System
						  Description 
						
 
					 	 
						A brief
						  description of this system. 
						
 
					 
	 
						SNMP
						  Port Number 
						
 
					 	 
						The
						  default port for SNMP applications is UDP 161. If your NMS uses a different
						  port, you can change that value here. 
						
 
					 
	 
						Enable
						  Authentication Traps 
						
 
					 	 
						Check if
						  you wish to enable Authentication Traps. 
						
 
						When a
						  device receives an authentication that fails, the device sends a trap to the NMS. 
						
 
					 

 
		  

	Step 5	You can change
			 the Windows Execution Priority of the Cisco SNMP agents in the 
			 Agent
				Performance section under 
			 Execution Priority. The default is 
			 Below
				Normal. You can further lower it by setting it to 
			 Low. Keep
			 the settings at the default levels unless you see a significant
			 performance impact. 
		  

	Step 6	You can also
			 further modify SNMP Agent Performance by changing the number of 
			 Concurrent
				Requests, Subagent Wait Time (in seconds), and 
			 Subagents.
			 the default values are 5, 25, and 25 respectively. Keep the settings at the
			 default levels unless you see a significant performance impact. 
		  
 
			 Definitions: 
			 	Concurrent
					 requests 
				  
	The maximum
					 number of SNMP requests that a subagent can concurrently process. Any
					 pending requests above this value are queued. 
				  
	Subagent
					 Wait Time 
				  
	The maximum
					 number of seconds that the master agent waits for a subagent response. 
				  
	Subagents 
				  
	The maximum
					 allowable subagents that the master agent loads. 
				  

 
			 
 
		  

	Step 7	To change
			 the amount of information written to the SNMP logs,  choose Verbose (most
			 information), Normal (Default), or Terse (least information). Only change this value under direction from Cisco Technical Assistance (TAC). 
		  

	Step 8	Click 
			 OK to save changes that you made. 
		  





Configuration of Trap and Syslog Destinations
[/topic/titlealts/navtitle
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Use the
Cisco SNMP Agent Management Snap-in to access the configuration screens.
	[image: images/note.gif]
Note
	Restarting the service does not clear conflicts between host address and
SNMP destination. When there is a conflict between the host address list and
the SNMP Trap Destination, if you delete the items from the host address list,
and restart the service, the configuration is reset.
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Configure SNMP Trap
	 Destinations
[/task/titlealts/navtitle
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	  (navtitle]
 
		You can configure
		  SNMP Trap Destinations for SNMP v1, SNMP v2c and SNMP v3. A Trap is a
		  notification used by the SNMP agent to inform the NMS of a certain event. 
		
 
		Follow these steps
		  to configure the trap destinations: 
		
 
	 Procedure


	Step 1	Follow the steps
			 in 
			 How to
				install the Cisco SNMP Agent Management Snap-in to access the Cisco
			 SNMP Agent Management settings. 
		  

	Step 2	Expand 
			 Cisco
				SNMP Agent Management in the left pane of the MMC plugin. 
		  

	Step 3	Highlight 
			 Trap
				Destinations in the left pane under Cisco SNMP Agent Management. 
		  
Trap
			 Entity Name and SNMP Version columns appear in the right pane. 
		  

	Step 4	Right click on
			 the white space in the middle pane and choose 
			 Properties. 
		  
A dialog
			 box appears. 
		  

	Step 5	Click 
			 Add Trap
				Entity. 
		  

	Step 6	Under 
			 Trap
				Entity Information select the SNMP version radio box for the
			 version of SNMP used by your NMS. 
		  

	Step 7	Provide a name
			 for the trap entity in the 
			 Trap
				Entity Name field. 
		  

	Step 8	Select the SNMP
			 Version Number. 
		  

	Step 9	Select the User
			 Name/Community Name that you want to associate with this trap. This list is
			 auto-populated with existing users/community names that have already been
			 configured. 
		  

	Step 10	Enter one or
			 more IP addresses in the IP Address entry field (containing 
			 "dots") and
			 click 
			 Insert to define the destination(s) for the trap(s).
			 
		  

	Step 11	Click 
			 Save to save the new trap destination. 
		  
 
			 The Trap Entity
				Name appears in the 
				Trap
				  Entities section at the top of the dialog box. 
			 
 
			 	Note
	You can
				remove the Trap Entity by highlighting the name in the 
				Trap
				  Entities section and clicking 
				Remove
				  Trap Entity. 
			 


 
		  

	Step 12	Changes become
			 effective when you click 
			 OK 
		  





Configure Syslog
	 Destinations
[/task/titlealts/navtitle
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			You can configure Syslog destinations for SNMP from the Cisco SNMP Agent Management Snap-in. The syslog feed is only available on the Unified ICM/CCE Logger Node. 

			Before you configure the syslog destinations, you must start the syslog process (cw2kfeed.exe) from the Web Setup tool.

				
					Open the Web Setup tool

				
	
					Select Component Management > Loggers, and then choose the instance of the logger for which you want to enable the syslog event feed.

				
	
					In the Additonal Options area, check the Enable Syslog check box to enable the syslog event feed process.

				


			These steps runs the CW2KFEED process when the logger is started.

			Follow these steps to configure Syslog destinations: 

		Procedure


	Step 1	Follow the steps
			 in 
			 How to
				install the Cisco SNMP Agent Management Snap-in to access the Cisco
			 SNMP Agent Management settings. 
		  

	Step 2	Expand 
			 Cisco
				SNMP Agent Management in the left pane of the MMC plugin. 
		  

	Step 3	Highlight 
			 Syslog
				Destinations in the left pane under Cisco SNMP Agent Management. 
		  
ICM
			 Instance Name, Feed Enabled, Collector Address, Port, and Ping Disabled columns
			 appear in the right pane. 
		  

	Step 4	Right click on
			 the white space in the right pane and choose 
			 Properties. 
		  
A dialog
			 box appears. 
		  

	Step 5	Select an
			 Unified ICM/CCE Instance from the list box. 
		  

	Step 6	Check the 
			 Enable
				Feed? checkbox. 
		  

	Step 7	In the 
			 Collector Address field, enter the IP address or
			 Host Name. 
		  

	Step 8	(Optional)  In the 
			 Collector Port field, enter the collector port
			 number on which syslog collector is listening. 
		  
 
			 	Note
	The default
				port is 514. 
			 


 
		  

	Step 9	(Optional) Check the 
			 Disable
				Ping Tests? checkbox. 
		  

	Step 10	Click 
			 Save. 
		  

	Step 11	Changes become
			 effective when you click 
			 OK and restart the logger. 
		  





Manage SNMP Service
[/task/titlealts/navtitle
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		In general, the Cisco Contact Center SNMP Management Service is always
		  running. 
		
 
		To confirm that the Cisco Contact Center SNMP Management Service is
		  running or to restart or stop it, follow these steps: 
		
 
	 Procedure


	Step 1	From the Windows desktop, choose 
			 Start > Settings > Control
				  Panel.
		  

	Step 2	Double-click 
			 Administrative Tools. 
		  

	Step 3	Double-click 
			 Services. 
		  
 
			 The 
				Services window appears. 
			 
 
		  

	Step 4	Look at the Status field in the 
			 Cisco Contact Center SNMP Management service
			 row. 
		  



 
		If this field displays 
		  "Started," the Cisco Contact Center SNMP Management Service is
		  running. If this field is blank, the Cisco Contact Center SNMP Management
		  Service is not running. 
		
 
		To start the Cisco Contact Center SNMP Management Service, right-click
		  
		  Cisco Contact Center SNMP Management and choose 
		  Start. 
		
 
		To stop the Cisco Contact Center SNMP Management Service, right-click
		  SNMP Service and choose 
		  Stop. 
		
 
		To restart the Cisco Contact Center SNMP Management Service,
		  right-click 
		  Cisco Contact Center SNMP Management and choose 
		  Restart. 
		
 
	 

Chapter 3. Responding to Alarms
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Notification
	 Mechanism
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		SNMP notifications
		  are error or warning events generated by component processes and are delivered
		  to a network management station (NMS) via SNMP. The MIB component notification
		  types describe objects which allow for correlating events and for easily
		  identifying the component that generated the event. 
		
 
		SNMP notifications
		  are derived from the event message stream continually being generated by the
		  various Cisco Unified ICM/CCE processes throughout the system. These processes
		  report events of interest to the central database as they occur. Just before
		  being placed in the central database, the event stream is intercepted by a
		  process called the Customer Support Forwarding Service (CSFS) that watches for
		  events of significant interest which should be treated as SNMP notifications. 
		
 
		Most Unified ICM/CCE
		  SNMP notifications are 
		  "stateful" in
		  that the notification reports a 
		  "raise" or a 
		  "clear" state
		  for a given error or warning event. Stateful notifications may or may not
		  require system administrator intervention; often, the Unified ICM/CCE system's
		  fault tolerance features allow the system to recover automatically. Other
		  notifications are 
		  "stateless"
		  (e.g. 
		  "single-state
			 raise") whereby a 
		  "clear" event
		  will not be forthcoming and resolution requires system administrator
		  intervention. 
		
 
		The CSFS process
		  running on the logger generates an event feed to a Cisco SNMP subagent which
		  converts the event data into an SNMP notification in the format defined by a
		  Cisco Unified ICM/CCE MIB. Notifications are defined by the
		  CISCO-CONTACT-CENTER-APPS-MIB. 
		
 
	 

Event Correlation
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		Events are sent to the NMS as a series of raise and clear events. A single clear event can clear multiple raise event. Events that relate to each other are given the same correlation ID. 
 
		The correlation ID is a combination of the event class name and the event component ID. The component ID (available in the MIB) is a combination of the class name and any substitution strings (arguments) that are passed into it. 
 
		To provide an organized view of events you need to create rules in your NMS to map events to a state-based object, using the correlation IDs to associate the events into like groups. When a clear event comes into the NMS you can cancel all previous raises that have the same correlation ID as the clear. 
 
		These Raise and Clear are defined in the file <INSTALL_DRIVE>/icm/snmp/ccca-Notifications.txt, which is found in the SNMP folder of your installation. 
 
			[image: images/note.gif]
Note
	Some raise event have no automatic clear and must be manually cleared. You should set up an escalation path within your NMS for events that do not have a corresponding clear event. 


 
		The ccca-Notifications.txt file contains a list of all alarms and each alarm contains an ccaEventState (Raise/Clear) and correlation ID. Based on correlation ID, you can determine if a Raise event has a corresponding Clear event or must be manually cleared. 
 
		 This information is also available as part of the event; RAISE=9 requires a manual Clear and RAISE=4 is an event that has a corresponding Clear. 
 
	 

SNMP
	 Notifications
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       {"- topic/navtitle "}) SNMP
		Notifications
	  (navtitle]

		Unified CCE SNMP
		  subagents are installed and enabled by default. To enable the flow of
		  notifications to the management station, on the Logger node, the installer must
		  first configure a community string (SNMP v1/v2c) or a user name (SNMP v3), and
		  a trap destination. These properties specify security parameters to use for
		  notification transport and the network management station that will receive the
		  Unified CCE notifications.
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About this Guide
This document describes the Simple Network Management Protocol (SNMP) feature support found in Unified Intelligent Contact Manager/Contact Center Enterprise & Hosted. 


Audience
This document is intended for System Installers, Unified ICM/CCE Administrators, and Network Administrators.
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                            Link
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                            Staging Guide for Cisco
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                            Pre-installation Planning
				  Guide for Cisco Unified ICM 

                        	
                            http://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-enterprise/products-installation-guides-list.html

                        
	
                            Serviceability Guide for
				  Cisco Unified ICM/Contact Center Enterprise

                        	
                            http://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-enterprise/products-installation-and-configuration-guides-list.html
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Communications, Services, and Additional Information

				
					To receive timely, relevant information from Cisco, sign up at Cisco Profile Manager.

				
	
					To get the business impact you’re looking for with the technologies that matter, visit Cisco Services.

				
	
					To submit a service request, visit Cisco Support.

				
	
					To discover and browse secure, validated enterprise-class apps, products, solutions and services, visit Cisco Marketplace.

				
	
					To obtain general networking, training, and certification titles, visit Cisco Press.

				
	
					To find warranty information for a specific product or product family, access Cisco Warranty Finder.

				


		Cisco Bug Search Tool

			
			Cisco Bug Search Tool (BST) is a web-based tool that acts as a gateway to the Cisco bug tracking system that maintains a comprehensive list of defects and vulnerabilities in Cisco products and software. BST provides you with detailed defect information about your products and software.

		

Field Alerts and
	 Field Notices
Cisco can modify its
		products or determine key processes to be important. These changes are
		announced through use of the Cisco Field Alerts and Cisco Field Notices. You
		can register to receive Field Alerts and Field Notices through the Product
		Alert Tool on Cisco.com. This tool enables you to create a profile to receive
		announcements by selecting all products of interest. 
	 
Sign in 
		www.cisco.com and then access the tool at 
		https://www.cisco.com/cisco/support/notifications.html.
		
	 


Documentation
	 Feedback
To provide comments about this document, send an email message to the following address: contactcenterproducts_docfeedback@cisco.com. 
We appreciate your
		comments. 
	 


Conventions
This document uses
		the following conventions: 
	 
	 
				  Convention
					 
				  
 
					 
				  Description 
				  
 
				
	 
				  boldface font 
				  
 
					 
				  Boldface
					 font is used to indicate commands, such as user entries, keys, buttons, and
					 folder and submenu names. For example: 
				  
 
				  	 
						Choose
						  
						  Edit > Find. 
						
 
					 
	 
						Click 
						  Finish. 
						
 
					 

 
				
	 
				  italic font 
				  
 
					 
				   Italic
					 font is used to indicate the following: 
				  
 
				  	 
						To
						  introduce a new term. Example: A 
						  skill group is a collection of agents who share similar
						  skills. 
						
 
					 
	 
						A
						  syntax value that the user must replace. Example: IF (condition, true-value,
							 false-value) 
						
 
					 
	 
						A book
						  title. Example: See the 
						  Cisco Unified Contact
				  Center Enterprise Installation and Upgrade Guide.
 
					 

 
				
	 
				  window font 
				  
 
					 
				  Window
					 font, such as Courier, is used for the following: 
				  
 
				  	 
						Text
						  as it appears in code or that the window displays. Example: 
						  <html><title>Cisco Systems, Inc.
							 </title></html> 
						
 
					 

 
				
	 
				  < > 
				  
 
					 
				  Angle
					 brackets are used to indicate the following: 
				  
 
				  	 
						For
						  arguments where the context does not allow italic, such as ASCII output. 
						
 
					 
	 
						A
						  character string that the user enters but that does not appear on the window
						  such as a password. 
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